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Uvod 

Hvala Vam na odabiru Vip e-SMS-a. Vip e-SMS omogućuje Vam slanje SMS (tekstualnih) i MMS (multimedijskih) poruka s 
osobnog računala s instaliranim operativnim sustavom Microsoft® Windows® na bilo koji mobilni telefon diljem svijeta. 

Ovaj vodič će Vam pomoći kod prvog susreta s Vip e-SMS-om, od instalacije do upoznavanja s većinom opcija. Prikazi i ikone 
prikazane u ovim Uputama mogu imati drugačiji izgled u operativnom sustavu Windows Vista.  

 

Zahtjevi 

Vip e-SMS koristi internet za slanje poruka te je stoga potrebna internetska veza. Nema nikakvih ograničenja brzine veze, a 
modemska veza bit će jednako dobra kao i LAN veza. 

Kako biste instalirali Vip e-SMS dodatak za Microsoft® Outlook Express®, morate imati instaliran Outlook Express. Inačica 
programa mora biti Microsoft® Outlook Express® 5.0, 5.5 ili 6.0.  

U operativnom sustavu Windows Vista, program Windows Mail zamijenio je Outlook Express.  

 

Nadalje, morate imati Microsoft® Windows® 2000, XP (Home ili Professional) ili Vistu s Internet Explorer-om 6.0 ili 7.0 i 
aktivirani Active Desktop. 

 

Podrška za Unicode 

Vip e-SMS koristi hrvatski kao svoj lokalni jezik. To znači da pojedina slova možda neće biti ispravno prikazana ako 
Regionalne i jezične mogućnosti («Regional and Language Options») nisu postavljene sukladno tome. Ako hrvatska slova 
nisu ispravno prikazana u Vašoj Vip e-SMS aplikaciji, promijenite Regionalne postavke Vašeg računala tako da otvorite 
Upravljačku ploču («Control Panel») i dvaput kliknite na Regionalne i jezične mogućnosti («Regional and Language 
Settings»). U prozoru koji se pojavi kliknite na karticu Dodatno («Advanced») i odaberite Hrvatski («Croatian») iz padajućeg 
popisa jezika (vidi sliku ispod). 
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Instalacija 

Ukoliko imate raniju inačicu Vip e-SMS-a instaliranu na 
Vašem računalu, preporučujemo Vam da istu prvo 
deinstalirate. Za informacije o deinstalaciji programa 
upućujemo Vas na poglavlje Deinstalacija. 

Za instaliranje Vip e-SMS-a morate preuzeti instalacijsku 
datoteku na Vaše računalo. 

 

Pronađite instalacijsku datoteku na Vašem računalu i 
kliknite dvaput na nju. Kod pokretanja instalacije prikazuje 
se početni zaslon. 

 

Kliknite na gumb Dalje za nastavak instalacije. 

  

Prikazuje se Licencni ugovor; ako želite prihvatiti 
odredbe Ugovora, kliknite na Prihvaćam uvjete 
licencnog ugovora. Potvrdite odabir klikom na Dalje. 

 

 

Gornji prozor bit će prikazan ukoliko posjedujete 
administratorska prava za Vaše računalo. Ovdje možete 
odrediti želite li instalirati Vip e-SMS za sve korisnike 
računala ili isključivo za vlastito korištenje. Potvrdite 
odabir klikom na Dalje. 

 

U sljedećem prozoru možete odrediti Standardnu ili 
Prilagođenu instalaciju.  

 

Standardna instalacija uključuje sve funkcije dok ćete, ako 
odaberete Prilagođenu instalaciju, imati mogućnost 
poništiti odabir nekih funkcija poput integracije u Outlook 
Express i/ili alatnu traku Internet Explorer-a.  

 

NAPOMENA: Ukoliko naknadno poželite instalirati funkciju 
čiji ste odabir bili poništili, morat ćete ponovno pokrenuti 
instalaciju Vip e-SMS-a. 

Potvrdite odabir klikom na Dalje. 
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U sljedećem prozoru možete promijeniti mapu za 
instalaciju Vip e-SMS-a. Zadano mjesto za instalaciju je 
C:\Program Files\Vip e-SMS Desktop. Ukoliko želite 
promijeniti mapu, kliknite na Pregledaj, odaberite 
odredišnu mapu i kliknite na Instaliraj kako biste nastavili 
instalaciju.  

Program za instalaciju sada instalira Vip e-SMS na Vaše 
računalo. Dijaloški okvir tijeka sličan sljedećem bit će 
prikazan tijekom instalacije. 

  

Po dovršetku instalacije, bit će prikazan sljedeći prozor. 

 

 

Kliknite na gumb Kraj kako biste dovršili instalaciju. 

 

Registracija 

Po dovršetku instalacije aplikacija se automatski otvara te 
se prikazuje zaslon dobrodošlice kako je prikazano u 
nastavku. U ovom trenutku možete nastaviti instalacijski 
program ili odabrati Odustani za izlazak iz zaslona 
dobrodošlice. Ako ne nastavite instalaciju odmah, zaslon 
dobrodošlice ponovno će biti prikazan u svakom od 
sljedećih slučajeva: 

 pri pokretanju aplikacije (u izborniku Start odaberite 
izbornik Programi i programsku grupu Vip e-SMS 
Desktop, zatim Novi MMS ili Novi SMS). 

 pri odabiru bilo koje opcije s popisa Vip e-SMS ikone u 
paleti sustava (System Tray) (u donjem desnom kutu 
Windows-a) 

  Klikom ili odabirom bilo koje opcije na Vip e-SMS 
alatnoj traci Internet Explorer-a 

Na zaslonu dobrodošlice, kliknite na Dalje radi 
registracije. 

 

Izgled čarobnjaka Otvori račun može se razlikovati od 
ovog primjera. Kako biste nastavili s registracijom, trebate 
unijeti Vaš broj mobitela. Broj unesite u obliku 
091xxxxxxx. 

  

Nakon što ste unijeli broj mobitela, kliknite na Dalje. 

Program sada provjerava podatke koje ste unijeli s 
poslužiteljem. Na broj mobitela koji ste unijeli primit ćete 
SMS poruku koja će sadržavati registracijski kôd. 
Program će tražiti od Vas unos tog kôda. Unesite 
registracijski kôd i kliknite na Završi. 
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Sada je Vaš račun otvoren i možete početi koristiti Vip e-
SMS za slanje SMS i MMS poruka. 

 

NAPOMENA: pri instalaciji na operativnom sustavu 
Windows Vista bit će potrebno ponovno pokrenuti 
računalo. 

 

Slanje SMS poruke 

Za izradu SMS poruke, otvorite prozor Novi SMS. To 
možete učiniti na više načina: 

U MS Windows: 

 Kliknite desnom tipkom miša na ikonu u paleti sustava 
(System Tray) te odaberite Novi SMS. 

  

 Kliknite dvaput na ikonu Vip e-SMS Desktop na radnoj 
površini. 

 Otvorite novu poruku preko ikone Start u MS Windows: 
odaberite Programi («Programs»), Vip e-SMS 
Desktop te Novi SMS.  

 

 U bilo kojem Vip e-SMS prozoru 

  - U bilo kojem Vip e-SMS prozoru kliknite na            
Datoteka -> Novi SMS.  

 - U bilo kojem Vip e-SMS prozoru osim prozora Novi 
SMS ili Novi MMS, kliknite na gumb Novi SMS. 

  

 

U Outlook Express-u 

- Kliknite na gumb Novi SMS na alatnoj traci: 

  

- U glavnom izborniku odaberite Message -> Novi SMS.  

  

 U Internet Explorer-u 

 - Odaberite Novi SMS u padajućem izborniku Vip e-
SMS alatne trake 

 - Označite tekst u prozoru internetskog preglednika, 
kliknite na desnu tipka miša i odaberite Pošalji kao 
SMS. 

  

Otvara se prozor Novi SMS. 
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Unesite broj mobitela primatelja u polje Prima. Ako 
želite dodati više primatelja, razdvojite ih točkom-
zarezom. Zatim unesite poruku u prostoru tijela poruke. 

Kliknite na gumb Pošalji za slanje poruke. 

Broj znakova 

 

Broj znakova i broj poruka koje ste napisali bit će 
prikazani u traci stanja na dnu prozora. Vip e-SMS poruka 
može se sastojati od najviše 765 znakova (dužina 5 Vip e-
SMS poruka). Poruka duža od 160 znakova bit će 
poslana kao nekoliko povezanih Vip e-SMS poruka 

 

PRIMJER: na traci stanja prikazano je «280(2)» što Vam 
govori da ste unijeli 280 znakova i da će Vip e-SMS 
poruka biti poslana kao dvije povezane poruke, jedna 
poruka sa 160 znakova i druga sa 120 znakova. To je 
moguće jedino ako je odabrana Opcija Duge poruke.-> 
Omogući poruke do 765 znakova (poslane kao 
nekoliko povezanih SMS poruka). 

Raspored slanja poruka 

Za svaku novu poruku možete odrediti kasnije vrijeme 
isporuke umjesto trenutnog slanja poruke. Kliknite na 
gumb Raspored slanja poruka (prikazano ispod) ili 
odaberite Poruka � Raspored slanja poruka.  

 

Otvara se prozor Raspored slanja poruka. 

 

 

Ova postavka omogućuje pošiljatelju da poruku pošalje 
odmah (zadana vrijednost) ili da odredi da poruka bude 
poslana kasnije u određeno vrijeme. U potonjem slučaju, 
polja za datum i vrijeme koriste se za određivanje 
vremena kada bi poruka trebala biti poslana. Sve poruke 
za koje je određen raspored slanja pohranjene su u 
Odlaznim porukama do njihovog slanja. 

Odabir primatelja iz Windows 
adresara (Kontakti) 

Možete odabrati primatelja iz Windows-ovog adresara, 
koji je također poznat pod imenom «Kontakti» 
(«Contacts») u Windows Visti. U tu svrhu kliknite na gumb 
Prima. Pojavit će se dijaloški okvir s Vašim kontaktima, u 
kojemu možete odabrati kontakte kojima želite poslati 
poruku. Možete također odabrati grupe primatelja 
(distribucijske liste); poznate također pod imenom 
Windows kontakt grupe – «Windows Contact Groups». 

U dijaloškom okviru Adresara («Address Book») Vip e-
SMS-a grupe primatelja bit će prikazane samo jednom za 
svaku vrstu broja (mobilni, kućni, službeni...) koja je 
zajednička uključenim kontaktima / drugim grupama 
primatelja. 

PRIMJER: 

- «Grupa 1» uključuje kontakte «Kontakt 1» (mobilni, 
kućni, službeni, službeni faks) i «Kontakt 2» 
(mobilni, kućni, službeni, dojavljivač) 

� «Grupa 1» bit će prikazana sa zajedničkim 
vrstama brojeva koje ta dva kontakta sadrže: 
Mobilni, kućni, i službeni 

- grupa «Grupa 2» uključuje kontakte «Kontakt 3» 
(mobilni, kućni, dojavljivač), «Kontakt 4" (mobilni, 
dojavljivač), «Kontakt 5» (mobilni, kućni, kućni faks, 
dojavljivač) i grupu «Grupa 1» (mobilni, kućni, 
službeni) 

� «Grupa 2» («Group 2) bit će prikazana sa 
zajedničkim vrstama brojeva koje ta tri 
kontakta i jedna grupa sadrže: samo mobilni 

NAPOMENE: Grupe u Windows Visti su ispravno prikazane 
bez obzira na bilo kakve cikličke reference između grupa 
(«Grupa A» koja sadrži «Grupu B» i «Grupa B» koja 
sadrži «Grupu A») i bez obzira na bilo kakve samo-
reference unutar grupa («Grupa A» sadrži «Grupu A»). 

Kliknite dvaput na ime primatelja kojemu želite poslati 
poruku te kliknite na U redu radi dodavanja primateljevih 
brojeva mobilnog telefona u prozor Novi SMS ili Novi 
MMS. 

Odabirom okvira za označivanje Prikaži samo kontakte 
s brojem mobitela moguće je filtrirati i ukloniti korisnike 
bez broja mobitela.  

 

 

Stvaranje novog kontakta 

Aplikacija provjerava izmjenu kontakata iz Windows 
Adresara («Windows Address Book») prigodom svakog 
prikazivanja prozora «Novi SMS» ili «Novi MMS» kao i 
prigodom svakog prikazivanja dijaloškog okvira Vip e-
SMS Adresara («Address Book»). 
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Za informacije o stvaranju novih kontakata i grupa 
pogledajte Pomoć za Windows („Windows Help“). Samo 
kliknite na gumb Windows imenik na alatnoj traci Vip e-
SMS-a te pristupite poglavlju Pomoć pritiskom na 
tipku F1. 

 

Brza pretraga imena kontakta 

Kada popunjavate polje Prima za slanje SMS/MMS 
poruke možete tražiti kontakte i grupe unosom bilo kojeg 
dijela imena/broja telefona kontakta ili bilo koji dio 
imena/vrste broja telefona grupe. Bit će prikazani svi 
kontakti i skupine koji se podudaraju; možete se kretati 
pomoću strelica i miša na popisu rezultata brze pretrage 
kako biste odlučili koji kontakt ili grupu dodati. Za 
dodavanje kontakta/grupe, jednostavno pritisnite tipku 
Enter ili kliknite lijevom tipkom miša na željeni kontakt.  

Ako želite dodati više primatelja, unesite točku-zarez iza 
prethodnog primatelja i ponovite gornji postupak.  

Možete pregledati detaljne podatke o primatelju 
dvostrukim klikom na ime primatelja u polju Prima. 

Odlazne poruke 

Poruke za koje ste odredili raspored slanja prikazane su u 
Vašoj mapi Odlazne poruke u Mapama s porukama.  

 

Također se pohranjuju na središnjem poslužitelju za 
poruke. Poruke za koje ste odredili raspored slanja i koje 
još nisu poslane možete vidjeti u kartici Raspored slanja 
poruka u prozoru Opcije. 

Ako niste spojeni na poslužitelj u trenutku slanja poruke 
za koju ste odredili raspored slanja, dobit ćete poruku 
upozorenja da niste spojeni i da će poruka biti poslana 
kada budete ponovno spojeni. Zatim se poruka pohranjuje 
samo u mapi Odlazne poruke. Vip e-SMS će i dalje 
pokušavati poslati poruku poslužitelju za poruke. 
NAPOMENA: Ako Vip e-SMS ne uspije uspostaviti vezu s 
poslužiteljem za poruke prije zakazanog vremena 
isporuke poruke, poruka neće biti poslana. 

 

 

Slanje MMS poruke 

Ako želite izraditi MMS poruku, otvorite prozor Novi MMS. 
Kao i za SMS poruke, to možete učiniti na više načina: 

U MS Windows: 

 Kliknite desnom tipkom miša na ikonu u paleti sustava 
(System Tray) te odaberite Novi MMS. 

 Kliknite dvaput na ikonu Vip e-SMS Desktop na radnoj 
površini. 

 Otvorite novu poruku preko ikone Start u Windows-ima: 
odaberite Programi («Programs»), Vip e-SMS 
Desktop te Novi MMS. 

 Kliknite desnom tipkom miša na bilo koju podržanu 
vrstu multimedijske datoteke (npr. gif, bmp) i odaberite 
Send To (Pošalji) i Pošalji kao MMS (ili Vip e-SMS) 

 

U bilo kojem Vip e-SMS prozoru 

 U bilo kojem Vip e-SMS prozoru kliknite na Datoteka -
> Novi MMS.  

U bilo kojem Vip e-SMS prozoru osim prozora Novi SMS 
ili Novi MMS, kliknite na gumb Novi MMS. 

 

 

 

U Outlook Express-u: 

 Kliknite na gumb Novi MMS na alatnoj traci: 

 U glavnom izborniku odaberite Message -> Novi MMS.  

 

U Internet Explorer-u 

 Kliknite na gumb  i odaberite Novi MMS u 
padajućem izborniku Vip e-SMS alatne trake 

 Kliknite na sliku (podržani formati su JPG, GIF, BMP) 
desnom tipkom miša i odaberite Pošalji kao MMS. 

 

Otvara se novi MMS prozor. 
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Napomena: Funkcije za rukovanje kontaktima (adresar, 
grupe, itd.) opisane su u odjeljku Slanje SMS poruke. 

Primatelje MMS poruke moguće je dodati i u Cc: i 
Bcc:  poljima. 

Jednostavni MMS 

U prethodnom odjeljku prikazan je Jednostavni MMS - 
za slanje MMS poruka na jednoj stranici. Možete također 
odabrati Napredni MMS, koji Vam omogućuje 
sastavljanje i slanje MMS poruka na više stranica. Ako se 
prozor Novi MMS otvori kao Napredni MMS, možete 
prijeći na slanje Jednostavnog MMS-a odabirom Pregled 
-> Jednostavni MMS u glavnom izborniku prozora Novi 
MMS. Idući put kada otvorite prozor Novi MMS, sustav će 
pamtiti posljednji korišteni način rada i otvorit će novi 
prozor u tom načinu rada. 

NAPOMENA: Na svakoj stranici MMS poruke možete dodati 
slikovnu ili zvukovnu datoteku (ili obje) ili možete dodati 
video datoteku. Ne možete kombinirati video datoteku i 
slikovnu datoteku ili zvukovnu datoteku. Ukoliko to 
pokušate učiniti, dobit ćete poruku potvrde sličnu ovoj: 

 

Ako želite dodati novu datoteku (i ukloniti druge datoteke 
kako je naznačeno), kliknite na OK («U redu»). Ako želite 
izbjeći dodavanje nove datoteke i uklanjanje drugih 
datoteka, kliknite na Cancel («Poništi») 

NAPOMENA: Kada dodate multimedijsku datoteku u 
MMS poruku, ona će biti kodirana u Base64/ASCII kodu, 
koji prouzrokuje povećanje njezine veličine za 30 do 40%. 
Primjerice, dodavanjem zvukovne datoteke čija je veličina 
u Windows-ovom podatkovnom sustavu 10 kB povećat će 
se veličina MMS poruke za 13 do 14 kB. 

Umetanje slike 

Vip e-SMS podržava JPG, GIF i BMP formate slika. Ako 
želite dodati nepokretnu sliku u Vašu MMS poruku, 
koristite jedan od sljedećih postupaka: 

 Kliknite na gumb Umetni sliku u gornjem lijevom dijelu 
prostora za pregled medija: 

 

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Umetni sliku. 

 Povlačenje i ispuštanje („Drag and drop”) slikovnih 
datoteka podržano je na različitim mjestima u MS 
Windows: na radnoj površini (Desktop-u), u Internet 
Explorer-u, Windows Explorer-u, itd.  
Povučena slika mora biti postavljena u prostor za 
pregled medija. 

 Vip e-SMS otvara standardni Windows prozor za 
odabir datoteke omogućujući Vam time pronalazak i 
odabir slikovne datoteke koju želite umetnuti. 

 Možete kontrolirati veličinu i kvalitetu slika koje šaljete 
u MMS poruci. Te postavke imaju zadane vrijednosti 
koje možete postaviti u kartici MMS u prozoru Opcije 
(pojedinosti ćete naći u odjeljku Opcije). Ako ih želite 
promijeniti za određenu poruku, to možete učiniti na 
jedan od sljedećih načina: 

 - Kliknite na gumb Opcije slike. 

 

 - U glavnom izborniku prozora Novi MMS odaberite 
Poruka -> Opcije slike. 

Otvara se prozor Opcije slike. 

  

Pomoću kliznog izbornika Veličina slike postavite 
maksimalnu veličinu slike koju želite poslati u Vašoj 
poruci.  Ako je slikovna datoteka koju ste odabrali za 
slanje veća od veličine koju postavite ovdje, datoteka 
će biti smanjena na ovu veličinu. Ako je manja, veličina 
datoteke neće biti smanjena; slika će zadržati svoju 
izvornu veličinu. 

 NAPOMENA: Veličina slike koja je veća od odabrane 
maksimalne veličine bit će promijenjena tako da bude 
prilagođena odabranoj maksimalnoj veličini. Omjeri će 
biti zadržani tako da slika ne bude iskrivljena. 
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Primjeri: 

 - Ako ste za maksimalnu veličinu odabrali Mala 
(128x128) i ako dodate sliku od 400x200 piksela, slika 
će biti smanjena na 128x64. 

 - Ako ste za maksimalnu veličinu odabrali Velika 
(480x640) i ako dodate sliku od 400x200 piksela, 
veličina slike neće biti promijenjena – prilagođena je 
Velikoj veličini bez promjene veličine. 

 - Ako ste za maksimalnu veličinu odabrali Velika 
(480x640) i ako dodate sliku od 800x400 piksela, slika 
će biti smanjena na 640x320 piksela (radi zadržavanja 
omjera kada je dužina slike dva puta veća od njezine 
širine; 640x320 je najveća veličina slike takvih omjera 
koja će biti prilagođena za 480x640 piksela). 

 - Ako ste za maksimalnu veličinu odabrali Velika 
(480x640) i ako dodate sliku od 800x800 piksela, slika 
će biti smanjena na 480x480 piksela. (Slika mora biti 
zadržana kao kvadrat, a 640x640 ne bi bilo 
prilagođeno Velikoj veličini; 480x480 je najveći kvadrat 
koji je prilagođen.) 

 

Pomoću kliznog izbornika Kvaliteta slike postavite razinu 
kvalitete slike koju ćete poslati u Vašoj poruci.  Pri 
tome postoji kompromis između kvalitete i veličine 
datoteke: veća kvaliteta daje oštrije i privlačnije slike ali 
i veće datoteke, što znači da će poruka biti veća i da će 
više podataka biti proslijeđeno preko mreže kada 
pošaljete poruku (kod slanja MMS-a ne naplaćuje se 
GPRS promet). U prozoru Novi MMS prikazana je slika 
u odabranoj veličini i kvaliteti te možete vidjeti kako bi 
trebala izgledati primatelju. 

NAPOMENA: Mobilna mreža dodatno mijenja veličinu 
slika radi njihovog prilagođavanja zaslonu mobilnog 
telefona primatelja te stoga nema jamstva da će primatelj 
doista vidjeti ono što Vi vidite u prozoru Novi MMS. 

Brisanje slike 

Ako želite izbrisati odabranu sliku iz Vaše MMS poruke, 
postupite na jedan od sljedećih načina: 

 Kliknite na gumb Izbriši sliku u gornjem lijevom dijelu 
prostora za pregled medija: 

  

 U glavnom izborniku odaberite Mediji -> Izbriši sliku. 

Slika je izbrisana iz MMS poruke. Ako želite, možete tada 
ponovno odabrati sliku koju želite umetnuti. 

Umetanje video isječka  

Vip e-SMS podržava 3GP format video datoteke. Ako 
želite umetnuti video u Vašu MMS poruku, postupite na 
jedan od sljedećih načina: 

 Kliknite na gumb Umetni video u gornjem srednjem 
dijelu prostora za pregled medija: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Umetni video. 

 Povlačenje i ispuštanje („Drag and drop”) video 
datoteka podržano je na različitim mjestima u MS 
Windows: na radnoj površini (Desktop-u), u Internet 
Explorer-u, Windows Explorer-u, itd.  
Povučeni video mora biti postavljen u prostor za 
pregled medija. 

 

 Vip e-SMS otvara standardni Windows prozor za 
odabir datoteke omogućujući Vam time pronalazak i 
odabir videa koji želite umetnuti. 

Brisanje videa 

Ako želite izbrisati video isječak iz Vaše MMS poruke, 
postupite na jedan od sljedećih načina: 

 Kliknite na gumb Izbriši video u gornjem srednjem 
dijelu prostora za pregled medija: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Izbriši video. 

Video je izbrisan iz MMS poruke. Ako želite, možete tada 
ponovno odabrati neki video koji želite umetnuti. 

Reprodukcija videa 

Ako želite reproducirati video isječak koji ste odabrali, 
postupite na jedan od sljedećih načina: 

 Kliknite na gumb Prikaži video u gornjem srednjem 
dijelu prostora za pregled medija: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Prikaži video. 

Za reprodukciju video isječka potreban je softver za 
reprodukciju koji podržava format 3GP, npr. Real 
Player. Ako je na Vašem računalu instaliran potreban 
softver, Windows će otvoriti prozor softvera za 
reprodukciju videa i reproducirati video isječak. 

Umetanje zvuka 

Vip e-SMS podržava MIDI, AMR i WAV formate zvuka. . 
Zvukovnu datoteku možete umetnuti u Vašu MMS poruku 
na jedan od sljedećih načina: 

 Kliknite na gumb Umetni zvuk u gornjem desnom 
dijelu prostora za pregled medija: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Umetni zvuk. 

 Povlačenje i ispuštanje („Drag and drop”) zvukovnih 
datoteka podržano je na različitim mjestima MS u 
Windows: na radnoj površini (Desktop-u), u Internet 
Explorer-u, Windows Explorer-u, itd.  
 Povučena zvukovna datoteka mora biti postavljena u 
prostor za pregled medija. 
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 Vip e-SMS otvara standardni Windows prozor za 
odabir datoteke omogućujući Vam time pronalazak i 
odabir zvukovne datoteke koju želite umetnuti. 

Brisanje zvuka 

Zvukovnu datoteku možete izbrisati iz Vaše MMS 
poruke na jedan od sljedećih načina: 

 Kliknite na gumb Izbriši zvuk u gornjem desnom dijelu 
prostora za pregled medija: 

 
 

 

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Izbriši zvuk. 

Zvukovna datoteka je izbrisana iz MMS poruke. Ako 
želite, možete tada ponovno odabrati neku zvukovnu 
datoteku koju želite umetnuti. 

Reprodukcija zvuka 

Zvukovnu datoteku koju ste umetnuli u Vašu MMS 
poruku možete reproducirati na jedan od sljedećih 
načina: 

 Kliknite na gumb Pokreni zvuk u gornjem desnom 
dijelu prostora za pregled medija: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Pokreni zvuk. 

Za reprodukciju zvukovne datoteke potreban je softver za 
reprodukciju koji podržava format odabrane zvukovne 
datoteke, npr. Real Player. Windows reproducira 
zvukovnu datoteku u zasebnom softveru za 
reprodukciju. 

 

Napredni MMS 

Napredni MMS omogućuje Vam izradu i slanje MMS 
poruka na više stranica. Po primitku Vaše poruke, 
stranice će biti reproducirane na mobitelu primatelja 
prema redoslijedu kojim ste ih izradili u poruci. 

Ako želite prijeći na slanje Naprednog MMS-a, u glavnom 
izborniku prozora Novi MMS odaberite Pregled -> 
Napredni MMS. Idući put kada otvorite prozor Novi MMS, 
sustav će pamtiti posljednji korišteni način rada i otvorit će 
novi prozor u tom načinu rada. 

Kada koristite Napredni MMS, možete obraditi svaku 
stranicu kako je opisano za Jednostavni MMS. U ovom 
odjeljku su opisani samo dijelovi Naprednog MMS-a koji 
pružaju funkcije za više stranica. 

 

Na dnu prozora nalazi se opći pregled stranica Vaše 
MMS poruke. Na gornjoj snimci zaslona, poruka ima 
samo jednu stranicu, koja je duljine 10 sekundi («10 sek» 
ispod ikone stranice).  

NAPOMENA: Ova stranica ne može biti izbrisana jer 
svaka MMS poruka mora imati najmanje jednu stranicu; 
ako pokušate izbrisati zadnju preostalu stranicu, dobit 
ćete poruku o pogrešci. 

Ako želite dodati sliku, video ili zvuk na stranicu, kliknite 
na tu stranicu radi njezinog odabira te postupite kako je 
opisano pod naslovom Jednostavni MMS (prethodni 
odjeljak). Kada je neka stranica odabrana, središnji dio 
prozora funkcionira za tu stranicu poput prostora za 
pregled medija, na isti način kao kod Jednostavnog MMS-
a. 

Dodavanje stranice 

Ako želite dodati novu stranicu u MMS poruku, postupite 
na jedan od sljedećih načina: 

 Kliknite na gumb Dodaj stranicu u gornjem lijevom 
dijelu prostora za pregled stranica: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Dodaj stranicu. 

Nova stranica je dodana u MMS poruku i prikazana u 
prostoru za pregled stranica. Nova stranica se uvijek 
dodaje na kraju MMS poruke. 

Brisanje stranice 

Postoje dva načina brisanja stranice iz MMS poruke: 



 

Datum:  2008/11/17 str. 12 / 16 
 

 

 Kliknite na gumb Izbriši stranicu u gornjem lijevom 
dijelu prostora za pregled stranica. 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Izbriši stranicu. 

NAPOMENA: Ova mogućnost nije dostupna ako MMS 
poruka ima samo jednu stranicu. 

NAPOMENA: Koju ćete stranicu izbrisati ovisi o tome koju 
ste stranicu odabrali klikom. Ako je neka stranica 
odabrana, ta će stranica biti izbrisana. Ako nije 
odabrana nijedna stranica, bit će izbrisana posljednja 
stranica MMS poruke. 

Trajanje stranice 

Ako želite postaviti trajanje neke stranice (tj. trajanje 
reprodukcije stranice kada primatelj pregledava MMS 
poruku), odaberite stranicu jednostrukim klikom te 
postupite na jedan od sljedećih načina: 

 Kliknite na gumb Trajanje stranice u gornjem lijevom 
dijelu prostora za pregled stranica: 

  

 U glavnom izborniku prozora Novi MMS odaberite 
Mediji -> Trajanje stranice. 

Otvara se prozor Trajanje stranice. 

  

Ovdje duljinu u sekundama možete izravno unijeti u polje 
koristeći tipkovnicu ili strelice uz polje za postavljanje 
duljine. Kada ste završili kliknite na OK. 

NAPOMENA: Za koju ćete stranicu postaviti trajanje ovisi 
o tome jeste li odabrali neku stranicu klikom na nju. 
Ako je neka stranica odabrana, trajanje te stranice će 
biti promijenjeno. Ako nije odabrana nijedna stranica, 
bit će promijenjeno trajanje posljednje stranice MMS 
poruke (na to ukazuje sivom bojom istaknuto trajanje 
stranice koje je vidljivo na gornjoj snimci zaslona 
prostora za pregled stranica, na kojoj je prikazan gumb 
Trajanje stranice.) 

Mapa Odlazne poruke  

Nakon pritiska na gumb Pošalji, poruka će biti privremeno 
pohranjena u Odlazne poruke dok ne bude poslana s 
Vašeg računala. Ako Vaše računalo nije spojeno na 
internet u trenutku slanja poruke, poruka će se čuvati u 
Odlaznim porukama dok internetska veza ne bude 
ponovno uspostavljena. U slučaju neuspjelog slanja 
poruke, poruka će se čuvati u Odlaznim porukama, 
odakle ćete tu poruku moći ponovno sami poslati kasnije.  

Napomena: Ako ste odredili da poruka bude poslana 
kasnije (pogledajte odjeljak Raspored slanja poruka), 
poruka će biti pohranjena u Odlaznim porukama do 
vremena slanja koje ste unijeli. 

Pregled mape Odlazne poruke 

Odlaznim porukama možete pristupiti na nekoliko načina: 

Kliknite desnom tipkom miša na ikonu u paleti sustava 
(System Tray; u donjem desnom kutu Windows-a) te 
odaberite Odlazne poruke. 

 

Druga mogućnost je da u bilo kojem prozoru Novi SMS ili 
Novi MMS odaberete Pregled -> Odlazne poruke, ili 

kliknite na gumb  i otvorit će se prozor Mape s 
porukama. 

 

Odaberite mapu Odlazne poruke iz padajućeg popisa.  

U Outlook Express-u, u glavnom izborniku možete 
odabrati View -> Odlazne SMS/MMS poruke. 

U prozoru Mape s porukama, poruke su prikazane u 
glavnom okviru sa stupcima s oznakama Prima, Poruka, 
Poslano i Komentar.  

 

 

Pregled poruke 

Odaberite mapu Odlazne poruke iz padajućeg okvira i 
kliknite dvaput na poruku koju želite pregledati. 
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Uređivanje i ponovno slanje 
poruke 

Kliknite dvaput na poruku kako biste otvorili poruku radi 
njezinog uređivanja. Pritiskom na Pošalji, poruka će se 
smatrati novom porukom, a izvorna poruka će biti 
uklonjena iz Odlaznih poruka. Ova se funkcija može 
koristiti u slučaju neuspjelog slanja poruke.  

Brisanje poruka iz mape Odlazne 
poruke 

Neželjene poruke možete izbrisati iz mape Odlazne 
poruke njihovim odabirom i pritiskom na tipku «Delete» 
(na Vašoj tipkovnici) ili korištenjem opcije Izbriši iz 
izbornika Uredi. 

 

Mapa Poslane poruke  

Sve poruke koje su poslane s Vašeg računala pohranjuju 
se u mapi Poslane poruke. Tamo možete pregledati 
pojedinosti poslanih poruka kao i njihovo stanje isporuke. 

Pregled mape Poslane poruke 

Mapi Poslane poruke možete pristupiti na nekoliko 
načina:  

Kliknite desnom tipkom miša na Vip e-SMS ikonu u Paleti 
sustava (System Tray-u) te odaberite Poslane poruke.  

 

 

Druga mogućnost je da u bilo kojem prozoru Novi SMS ili 
Novi MMS odaberete Pregled -> Poslane poruke, ili 

kliknite na gumb  i otvorit će se prozor Mape s 
porukama. 

Odaberite mapu Poslane poruke iz padajućeg popisa. 

U Outlook Express-u, u glavnom izborniku možete 
odabrati View -> Poslane SMS/MMS poruke. 

U glavnom okviru poruke su prikazane sa stupcima s 
oznakama Prima, Poruka i Poslano. 

 

MMS i SMS poruke imaju različite ikone te ih je stoga 
moguće razlikovati na popisu. 

Pregled poruke 

Odaberite mapu Poslane poruke iz padajućeg okvira i 
kliknite dvaput na poruku koju želite pregledati. 

Uređivanje i prosljeđivanje 
poruke 

Kliknite dvaput na poruku koju želite otvoriti. Poruku 
možete proslijediti na način da kliknite na gumb 
Proslijedi, unesete nove primatelje i kliknete na gumb 
Pošalji.  

Brisanje poruka iz mape 
Poslanih poruka 

Neželjene poruke možete izbrisati iz mape Poslane 
poruke njihovim odabirom i pritiskom na tipku Izbriši 
«Delete» (na Vašoj tipkovnici) ili korištenjem opcije Izbriši 
iz izbornika Edit. 

 

Alatna traka Internet 
Explorer-a 

Alatnom trakom Internet Explorer-a Vip e-SMS nudi novi i 
brzi način slanja SMS poruka iz softvera koji koriste 
milijuni korisnika osobnih računala, to jest iz Microsoft© 
Internet Explorer-a.  

Korištenje alatne trake Vip e-
SMS-a 

Nakon instalacije Vip e-SMS-a, alatna traka Vip e-SMS-a 
bit će vidljiva u Internet Explorer-u kao dodatna alatna 
traka. Napomena: Tijekom instalacije imate mogućnost 
poništiti odabir alatne trake Vip e-SMS-a, u kojem slučaju 
neće biti instalirana. Ukoliko kasnije poželite koristiti 
alatnu traku Vip e-SMS-a, morat ćete ponovno instalirati 
aplikaciju. 

Na alatnoj traci Vip e-SMS-a možete jednostavno izraditi i 
slati SMS poruke. Alatna traka sastoji se od četiri dijela, s 
lijeva na desno: 

 - Gumba s Vip logotipom za pristup izborniku (v. opis u 
nastavku). 

 

 

 - Polja Prima u kojemu je moguće upisati ili povući i 
ispustiti broj ili nekoliko brojeva mobitela. 
 

Kontakte je moguće umetnuti i  iz Windows adresara 
(Kontakti). 

 
Kontakti se također umeću unosom jednog ili više 
slova imena primatelja u polje Prima te odabirom 
između ponuđenih kontakata. 

 Ukoliko u polju Prima pritisnete na tipku strelice dolje 
na tipkovnici, otvora se padajući izbornik u kojemu su 
prikazani svi kontakti iz Windows adresara s brojevima 
mobitela. 
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 - Polja Poruka u kojemu je moguće upisati poruku. 
Možete unijeti najviše 160 znakova. Tekst koji sadrži 
više od 160 znakova bit će skraćen. 

 
Polje Poruka podržava povlačenje i ispuštanje 
teksta („Drag and drop”). 

 

 - Gumba Pošalji - poruka se šalje nakon pritiska na 
gumb Pošalji. 

 

Pristupni izbornik  

Ako pritisnite gumb s Vip logotipom, otvorit će se pristupni 
izbornik. Iz ovog izbornika dostupne su, između ostalog, 
mape s porukama, Opcije te  funkcije slanja SMS i MMS 
poruka. 

 

Moguće je odabrati:  

 

 Naslovna stranica. Poveznica prema Vipnet 
internetskim stranicama. 

 Novi SMS. Otvara prozor za sastavljanje SMS poruke. 

 Novi MMS. Otvara prozor za sastavljanje MMS poruke. 

 Kontakti. Otvara Windows adresar (Windows Address 
Book). 

 Opcije. Otvara dijaloški okvir Opcija. 

 Mape s porukama 

- Poslane SMS poruke - Mapa sa svim poslanim 
porukama 

  - Odlazne SMS poruke - Mapa s porukama koje 
nisu poslane, npr. zbog zadanog rasporeda slanja 
poruka 

 Pomoć 

 O Vip e-SMS (informacije o Vip e-SMS aplikaciji) 

 Isključi 

Deaktiviranje alatne trake Vip e-SMS-a 

Alatnu traku je moguće skriti pomoću standardnog načina 
rukovanja alatnim trakama u Internet Explorer-u: Idite na 
View -> Toolbars -> Vip e-SMS Toolbar (Pregled -> 
Alatne trake -> Vip e-SMS Toolbar) radi njezinog 
aktiviranja ili deaktiviranja. 

 

 

Opcije 

Prozor Opcije omogućuje Vam konfiguriranje Vip e-SMS-
a kako bi ispunio Vaše vlastite potrebe.  

Za otvaranje prozora Opcije možete kliknuti na gumb 
Opcije u bilo kojem prozoru Novi SMS ili Novi MMS, ili 
odabrati Alati ���� Opcije u bilo kojem prozoru Vip e-SMS-
a. U glavnom izborniku Outlook Express-a možete 
također odabrati Tools -> SMS/MMS opcije (Alati -> 
SMS/MMS opcije). 

Gumb Opcije  dostupan je u svim prozorima Vip e-
SMS-a. 

 

Deinstalacija 

Program se vrlo jednostavno deinstalira odabirom 
Izbornika Start -> Programi -> Vip e-SMS Desktop -> 
Deinstaliraj («Start Menu -> Programs -> Vip e-SMS 
Desktop -> Deinstaliraj») i praćenjem uputa. Druga 
mogućnost je opisana u nastavku.  

U Izborniku Start («Start Menu») odaberite Postavke -> 
Upravljačka ploča («Settings -> Control Panel»). 
Otvara se Upravljačka ploča («Control Panel»). 
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Kliknite dvaput na ikonu Dodaj/ukloni programe 
(«Add/Remove Programs»). Otvara se prozor koji sadrži 
popis svih instaliranih programa po abecednom redu. 

 

 

 

Kliknite na redak na kojemu piše Vip e-SMS Desktop. 
Redak će se proširiti i bit će prikazane dodatne 
informacije o programu. Kliknite na gumb 
Promijeni/ukloni («Change/Remove») i potvrdite Vašu 
želju da uklonite program. 

NAPOMENA: Izgled prozora za Dodavanje/Uklanjanje 
programa («Add/Remove Programs») može biti malo 
drugačiji na nekim računalima ovisno o inačici Windows-a 
koju posjedujete. 

 

Kliknite na gumb Yes («Da») za deinstalaciju. 

Nakon što kliknete na Yes («Da»), instalirane datoteke i 
direktoriji bit će uklonjeni s računala. Kliknite na gumb 
Završi («Finish») kako biste dovršili deinstalaciju. 

Vip e-SMS je sada uklonjen s Vašeg računala i 
deinstalacija je dovršena. 

Napomena: mape Odlazne poruke i Poslane poruke neće 
biti izbrisane nakon deinstalacije radi sprječavanja 
neželjenog gubitka podataka. 

 


